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If you have any questions, comments or suggestions please contact us at any time: 
 

Vertigraph, Inc. 
12959 Jupiter Road, Ste 252 

Dallas, TX 75238 
425-223-4311 
877-902-2979 

support@vertigraph.com 
www.vertigraph.com 

  

 

 

mailto: support@interworldna.com
http://www.interworldna.com/vertigraph/bidscreen_xl.php
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BidScreen XL Preface  
 
A few words on performing the takeoff and estimate for construction activities: 

 Quantity Takeoff is performed by measuring certain items and then calculating the 
desired quantities from these measurements. 

 Estimating is applying costs to the quantities. 

Applying the estimated cost to the quantities is usually performed in either an Excel workbook or 

through a relational database estimating program.  We believe that organizing your takeoff 

quantities in Microsoft Excel, regardless of the software used for estimating, is often the easiest, 

most logical and best way to organize the takeoff for most contractors.  With this in mind, 

BidScreen XL is software that is specifically designed to be added to Microsoft Excel to allow 

you to measure items directly from electronic files such as PDF, TIFF, AutoCAD DWG and most 

other file types while working in MS Excel. Additional calculations applied to these BidScreen XL 

measurements are performed in Excel to arrive at the takeoff quantities and estimate. A concise 

audit trail is provided by automatically storing the drawing with the digitized measurement into 

any Excel workbook cell. In summary, BidScreen XL allows you to view and measure from 

many file types while clearly organizing your takeoff in any Excel workbook.  

 How easy is it to digitize measurements with BidScreen XL? 

Instructions for using BidScreen XL after adding it to MS Excel: 

1. Load the drawing and click the green checkmark to accept it 

2. Set the scale or CAD drawing unit 

3. Click on the cell where you want the quantity measurement recorded 

4. Select the measurement from the toolbar (i.e. Count, Section Length, Continuous Length 

or Area) 

5. Begin measuring with your mouse 

6. To finish, click the checkmark to record the number, drawing and overlay into the Excel 

cell 

Excel is not for everybody however; certain divisions of work, such as site excavation and some 

of the mechanical trades may be better served by performing the takeoff in trade specific, non-

spreadsheet applications.  Overwhelmingly however, Excel is the number one application by far 

for both large and small contractors for documenting takeoff quantities. In addition to the takeoff, 

Excel also has the largest market share among contractors for estimating the costs.   

As a result of the widespread use and power of Excel, we promote Excel estimating and have 

included a collection of takeoff and estimating workbook files for your use and review.  Many of 

our customers have already created their own Excel estimating template.  Others use the 

included Excel workbooks and customize these templates to fit their needs.  After installing the 

software, the Excel takeoff and estimating workbooks provided with BidScreen XL can be 

accessed from the BidScreen XL programs list (Start|All Programs|BidScreenXL|Example 

Workbooks). 

 

Minimum System Requirements:   Recommended System Requirements: 

Microsoft Windows Operating system   Windows Vista Operating System 
Microsoft Excel 2000+     Microsoft Excel 2003 or 2007 
2GB of RAM (XP) or 3GB (Vista)   3GB RAM (XP) or 4GB (Vista) 
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800 x 600 Display Resolution.     1440 x 900 Display Resolution 

 
 

Information regarding electronic files 
 
Architectural drawings are either vector or raster image files.  A raster image, such as a TIFF, 

PDF, BMP, and JPEG file, is a data file representing a grid of pixels (dots) on a computer 

monitor.  A vector file on the other hand represents an image in computer graphics created 

through the use and assembly of geometrical, mathematical shapes such as points, lines, 

curves and polygons.  AutoCAD DWG and DXF files are example of vector files.   

BidScreen XL operates differently depending on the type of file loaded.  

Please note the following: 

If you have licensed and installed the recommended version of Adobe Acrobat on your 

computer (Adobe Acrobat Standard or Professional 7 or later, not Reader), BidScreen XL will 

use the installed Acrobat for viewing all PDF files.  Vertigraph can bundle Adobe Acrobat 

Standard version 9 product at special pricing with BidScreen XL.  For further information, please 

contact Vertigraph, Inc. at 800-989-4243 or support@vertigraph.com. 

One of the advantages of vector files such as DWG and DXF is that you don’t select or calculate 

a drawing scale like you do with raster files.  Rather you’ll select the CAD drawing unit directly 

from the vector file, as long as the model layout is used, which generates much more accurate 

takeoffs than raster files. 

With vector files you’re able to turn on and off design layers (i.e. isolate layers).  Layer 

information that is not relevant to the current takeoff may be eliminated from view for easier 

takeoffs. 

Most importantly, the big advantage of CAD, vector files is the ability to snap to the design 

object while measuring with your mouse.  You can now obtain the exact measurements from the 

design object with vector files.  With raster files on the other hand, you’ll generate approximate, 

not exact, measurements by digitizing on points contained on the raster file. 
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Installation of BidScreen XL, eTakeoff of ePlans in Excel 
 
Step 1 – Install BidScreen XL Software 

 Install BidScreen XL from the Vertigraph disc or go to http://www.vertigraph.com and 
click on the Download Evaluation 

 Complete the requested information and click the Submit at the bottom of the page.  

 Click on the Evaluation link next to BidScreen XL and select save.  Do not run the 
installation from the web page.   

 Save the BidScreen XL_Setup.exe to your desktop and then double click BidScreen 
XL_Setup.exe on to begin installation (make sure MS Excel is closed before starting the 
installation). Follow wizard instructions. 

  
Step 2 - Add BidScreen XL to Microsoft Excel  

For Excel versions prior to 2007 

 From a blank Excel workbook Click on the Tools menu; click Add-Ins; click Browse and 
navigate to C:\Program Files\Vertigraph\BidScreen XL folder. 

 Click on the file named BidScreenXL.xla, and click OK.  This will place you back in the 
Add-Ins list, Click OK. 

 A BidScreen XL menu is added to the left of the Excel Help menu and a BidScreen 
XL toolbar is added.  If the toolbar is not displayed, click on View, Toolbars in Excel to 
insure the BidScreen XL toolbar is checked. If the BidScreen XL menu is not active or 
grayed out, exit Excel and reopen to activate the BidScreen XL menu.   

 
If you have Excel 2007 

 From a blank Excel workbook Click on the Office button on the top left hand corner of 
Excel and Select Excel Options.  

 From the Excel Options Window Click on Add-Ins on the left. 

 Click the Go button at the bottom of the page next to Manager Excel Add-ins; this will 
display your Add-Ins list. 

 Click browse and navigate to C:\Program Files\Vertigraph\BidScreen XL folder and then 
Click on the file named BidScreenXL.xla, and click OK.  This will place you back in the 
Add-Ins list. Click OK 

 An Add-Ins Tab is added to Excel and under the Tab the BidScreen XL menu and 
Toolbar will be located. 

  
Tips and Important Information for Setup and Operating BidScreen XL with Excel:   

 From the BidScreen XL Menu, click the Setup command and confirm “Use Acrobat” is 
checked under the Options Tab for users running Adobe Acrobat Version 7 or later. 
Vertigraph HIGHLY recommends using Adobe Acrobat Standard or Professional Version 
7.0 or 9.0 in conjunction with BidScreen XL to ensure compatibility with ALL versions of 
pdf files. For those evaluating BidScreen XL and not currently running Adobe Acrobat 7+ 
you can download an evaluation copy of Version 9.0 at www.adobe.com. If you have 
purchased BidScreen XL from Vertigraph and are not running Adobe Acrobat 7+ then 
you may purchase Adobe Acrobat Standard 9.0 at a discounted Value Bundle price from 
Vertigraph. 

 User specific setup options are located under Setup Menu at the Options Tab: 
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o Click on the  to change to the recommended User settings for Version 
5. This will place user specific Toolbars in the Takeoff Window along with your 
Style Palette for easy access. Additional Toolbars can be selected to display at 
the Takeoff Window under the Setup|Takeoff Window tab once you are more 
familiar with the BidScreen XL program. 

o If you prefer the previous versions of BidScreen XL click on the  
under the Options Tab to return the Takeoff Window to the “Classic” BidScreen 
XL look and feel.  

 Important program information: BidScreen XL writes Cell Comments to each digitized 
cell as well as the “Default Cell” for a Workbook/Worksheet. Each Workbook should 
contain only 1 Default Cell which holds the “brains” of the workbook for BidScreen XL; 
the Default Cell is typically cell A1 but may be A2 or B1 or B2. Care should be taken to:  

a) Not delete the Default Cell of a digitized workbook/worksheet should you wish your 
digitized information to be saved for future reference;  

b) Use caution when copying cells/columns/rows/worksheets that contain digitized 
information and  

c) When recycling a used/digitized workbook/worksheet be sure that ALL digitized cells, 
along with the Default Cell from a previously digitized job are removed. 

 All support documentation is installed with BidScreen XL in pdf format under C:\Program 
Files\Vertigraph\BidScreen XL\pdf. We recommend you go thru the short Tutorial 
document when starting your first takeoff to familiarize yourself with the basics of the 
program. A Training/Tutorial Video is also available for download at 
htp://www.vertigraph.com/pub/BidScreen XL_Training.zip.  

  

  



 6 

The BidScreen XL Setup window 
 

The following merely outlines some basic setup and operating tips of BidScreen XL.  
More detailed help and instructions may be accessed anywhere in the program by 

clicking on the Help button in any window.    
 
The Setup command is essential for properly configuring BidScreen XL.  The setup has four 
different tabs: Options, Takeoff Window, Reports and Styles, all of which can be setup and 
changed based on individual user preferences.   
 

The following options are the recommended settings.    
 

Options Tab Window 
 

  

 

 

 

 

 

 
 

 

 

 

 
 
 
 
 

 

Use Acrobat 
This option will only be enabled when 
Adobe Acrobat 7 or higher is installed 

(not Reader). If Adobe Acrobat is 
installed, please confirm this box is 

checked. 

Prompt for Scale on Open Drawing 

After loading and accepting a single 
drawing, if the Prompt for Scale on Open 
Drawing is checked, the scale dialog will 
automatically display.  This option does 

not apply to multiple page or multiple file 
opens. 

 

Accept Single Drawings - 
Recommended 

Displays single drawings as they are 
opened to allow for acceptance or 

rejection of the drawing. 

Accept Multiple Drawings - Option 

If enabled, each page of a multiple page 
file or each file of the same format in a 

common folder that is loaded will have to 
be accepted or rejected individually. If 

this option is disabled, then all pages or 
files are accepted and added to the 

drawing list. The default setting for this 
option is disabled. 

Automatic Update Check 

Enables Automatic electronic checking for 
updates/upgrades to BidScreen XL with 

electronic notification to user. 
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Takeoff Window Tab 
 
All of the following selections control the look and feel of the display of the takeoff window  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Status Bar 
Displays information about 
the drawing found at the 

bottom of the takeoff 
window. 

Information Bar 
Displays the following at top of 

takeoff window: 

 Name of  drawing 

 Style being used 

 File format  

 Current scale and 

factor. 

Style Palette 
Select styles from a palette 

that appears on the left 
hand side of the takeoff 

window 

Auto Hide Style 
Palette 

Will automatically 
hide or display the 
Style Palette when 

the cursor is moved 
over it. 

Tool Style 
Classic displays Version 3 

of BidScreen XL. 
 

Version 5 displays the 
toolbar groups in the 

takeoff window. 

 

Show Current Cell or 
Show All Cells 

All of your digitized 
measurements are displayed 
as you measure into a new, 

blank cell. 

Cad Toolbar 
Select the layout, snap to the 

object, select or deselect 
different layers in the 

drawing, change the color to 
monochrome, and change 
the thickness of the lines. 

 

Zoom 
Toolbar 

Zoom, zoom to 
selection, 

restore to full 
size, enable or 
disable scroll 

bars and pan. 

Draw Toolbar 
The following options are available 

on the takeoff window. 
 

Circle, Rectangle, Annotate, 
Highlight and Negative/Positive 
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The Takeoff window is where measuring will be done and the drawing will display.  The Cad, 
Draw, Zoom, Information and Status Toolbars will appear in this window if Version 5 is 
selected in the Setup menu.   
 
If Styles has been selected under the Options and Takeoff tab and Show Style Palette, they 
will both appear in this window as well. Auto Hide Style Palette can be selected in the Takeoff 
tab under Setup to hide the palette when not needed. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 
 
 
 

 

 
 

 

 

 

 
 
  

 

Draw 
Toolbar 

Status 
Toolbar 

Information 
Toolbar 

Style 
Palette 

Zoom 
Toolbar 

Cad 
Toolbar 
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Edit Keyboard Shortcuts 
 
BidScreen XL has numerous keyboard shortcuts assigned to many of the functions used during 

takeoff, such as Close Area or Delete Last Point.  The keyboard shortcuts are already setup by 

default.  However, if needed, the user has the option to change those keyboard strokes. 

 

To change any of these keyboard shortcuts, click on Edit Shortcuts.  This button is found by 

clicking on the setup command from the BidScreen XL menu and then clicking on the Takeoff 

window tab. 

 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

This shortcut editor displays (left) a list 
of all the actions that are assigned 
keyboard shortcuts.  
 
To change the combinations, select the 
action by clicking on the Shortcut Key 
column of the action. 
 
Then press the "Change" button.  

Change shortcut dialog appears.   
 
Press desired key combination 
and it will appear in the edit box.  
 
Click OK to save settings. 
 
Vertigraph Recommendations: 
 
Function Short Cut 
Arc   A 
Circle  C 
Rectangle R 
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Styles Tab Window 
 
Create and organize measurement styles at the Styles tab.  If the Styles tab does not appear, 
click back on the options tab and confirm Use Styles is checked. 
 
Use Styles 
 
Styles refer to the way the takeoff is displayed on the screen and how it appears when printed.  
To quickly identify different type of measurements or certain areas, there are five style 
characteristics available to make identifying those easier. 
 
Individual styles are organized into groups.  Groups may be defined in any logical manner.  
Some users organize their style groups by project name, CSI division, material type, 
subcontractor trade or even color.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

If Show Style Palette is selected, 
the styles created are available 
while digitizing drawings by 
clicking on them.       

 

 

Click Add 

Style 

Name the style; change 
the color, the style of 
pointer, the line width 
and style, and the fill 

pattern. 

 

Click Add 

Group 

Change the 
title of the 

caption 

In the Setup/Options tab you 
have the option to: 

1. Use Styles 
2. Share Styles,  
3. Change the default path of 

the Style File to a common 
location for sharing across 
multiple users and 
programs (ie.. BidPoint XL) 

4. Allow Writing  
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Loading and Viewing files with BidScreen XL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Load 

Drawing 

Open an Excel workbook, click on any cell except 

A1 and then load the desired drawing by clicking 

on the Load Drawing command found on the 

toolbar or by clicking on the BidScreen XL menu 

then the Load Drawing command. 

 

 

Browse for drawings by 

scrolling to the drive 

and the file path here 

or from the system 

icons on the left 

Tips when loading drawings 

with BidScreen XL. 

 Any shortcuts to url web sites or 

program executables in the path 

will prompt a message that 

“BidScreen XL is Unable to 

Resolve the Path….”.url”, “.lnk”. 

You can click OK thru these 

prompts but if you have several 

we recommend moving them to a 

closed folder.  

 If there is an = anywhere in the 

file name, an error message will 

appear. 

 We recommend drawings 

received via email, cd, or 

download be saved to a folder on 

your hard drive. 

 

Click in the “Look In” to navigate to the path C:\Documents and 

Settings\All Users\Documents\Vertigraph\BidScreen XL\drawings 

Here we will initially select the Floor_1.TIF 

file by browsing to the file path 

C:\Documents and Settings\All 

Users\Documents\Vertigraph\BidScreen 

XL\drawings folder to select the Floor_1.TIF  

under Windows XP. 

and 

C:\users\Public\Public 

Documents\Vertigraph\BidScreen XL  

under Windows Vista. 
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Once at the drawing folder, 

click on the file named 

Floor_1.TIF 

Preview of the drawing 

appears on the right 

Click on the file name and then the Open button 
to load an individual file.   
 
If there are multiple files of the same format in a 
folder, click on one of the files and then click the 
Files button to load all of the files of the selected 
type.  All files are loaded sequentially within the 
folder.  If you only need 10 files out of 50 for 
example, move the 10 files to a subfolder and load 
all of them with 1 click. 
 
Some PDF and TIF files contain multiple pages 
within one file.  BidScreen XL has the capability to 
load all of the pages or only certain selected 
pages.  To load all pages within a file, click on the 
file and then the Pages button.  If there is a page 
number under the image thumbnail on the right 
side of the Open Drawing File window, then the file 
has multiple pages. Unless you know you want all 
pages in this file we recommend you select Accept 
Multiple Drawings under the Setup/Options menu. 
 
To open a single page of a multiple page file, scroll 
through the page numbers and click Open on the 
desired page.   

 

 

Open 
Simply opens a 
single drawing 

Files 
Loads all the drawings 
of the same file type in 

this folder 

Pages 
Opens all the pages of 

a multipage file 

Cancel 
Cancels the load 

drawing operation 
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Use the buttons at 
the top to select 
English or Metric 

units 

Choose between 
Architectural 

and Engineering 

There are three scale 
options 

 
Auto Scale – 

Recommended to 
ensure accuracy.  

Press the digitize button 
and measurement two 

points a known distance.   
 

Manually enter the 
factors of the scale 

 
Select the scale from the 

drop down list 

 

 

Click the green 

checkmark to 

accept this drawing 

When loading drawings, a “Default” cell 

comment is placed in cell A1 or A2 that 

contains the drawing list index 

for the Excel workbook.  This is a critical 

cell comment.  DO NOT DELETE OR 

ERASE THIS CELL COMMENT IF YOU 

PLAN TO RETURN TO THIS 

WORKBOOK FOR FUTURE USE. 

 

An Excel cell comment is placed in the 

cell where the measurement is recorded 

and indicates a digitized drawing 

supports the number in the cell.  The cells 

with drawings may be copied and moved 

in MS Excel but care should be taken. 

 
 

We suggest maximizing the BidScreen 

XL takeoff window since many prefer to 

have the largest viewing area possible.  

Important: Please note that if the 
recommended version of Adobe Acrobat 
is not installed, we DO NOT recommend 
loading multi-page PDF files or multiple 
PDF files from a folder.  Load one file at 

a time. 

Zoom 
1. Toolbar 
2. By using the scroll wheel 

on the mouse. 
3. Holding Shift key and left 

click mouse (zooms in) 
and Shift key and right 
click mouse (zooms out) 

 
 

 
Note:  If you are loading a CAD file, such as a DWG, DXF or DWF, the CAD Drawing Unit 
dialog is displayed.  Select the drawing unit by clicking on the down arrow, normally 
displayed as feet or inches.   It is highly recommended to digitize the scale, using only the 

model layout, to determine the proper scale.   

Pan 
1. Toolbar 
2. Holding Ctrl key while 

pressing left mouse 
button and then dragging 
the mouse. 

3. Scroll bars 
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Shortcuts and Tips: 
 
To record the perimeter length of an area, you can digitize the area takeoff in one cell and then 
move to a new, blank cell and select the BidScreen XL | Continuous Length command.  Click 
the green checkmark to accept the measurement.  The perimeter length of the last area 
measured is placed in that cell.  
 
Section lines are ideal for measuring straight lines. A section line will only have two points, a 
beginning of line point and an end of the line point.  If the count number is even, the next point 
you click will be the beginning of the next line. If the count number displayed is an odd number, 
the next point you click will be the end the line.   
 
Once digitized, you can retroactively go back and change the digitized scale of a single, or 
multiple, cells by selecting the cell/cells and selecting the BidScreen XL | Change Scale 
command. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Section Length 
Measures straight lines 
with only two points.  

Count 
Counts items such as 

doors or walls 

Continuous Length 
Calculates the length of 

lines with multiple 
points and Perimeters 

Area 
Calculates Square 

footage 

Changing between drawings after it 
is already loaded is performed by 
clicking on the drop down drawing 
list found on the toolbar or selecting 
the drawing from the Thumbnails. 

Once a cell is digitized, the drawing 
name, takeoff type and digitized 
scale are displayed for you from the 
toolbar. Simply click on the cell to 
determine the digitized data it 
contains. 
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Printing in BidScreen XL 
 
To overlay and view or print takeoffs in multiple cells, click on the first cell and hold down the 
Ctrl key on the keyboard as you click on other cells that have digitized data.  Once all the cells 

are selected, select BidScreen XL | Print Drawing   to display the Print Preview Window.  
 
  
 
 
 
 
 
 
 

 
 

 
 
 
If you have any questions, suggestions or comments, please contact us at any time at 425-223-
4311, 877-902-2979 or www.vertigraph.com.  Congratulations, you’re now ready for a real 
project with BidScreen XL.  

Style Legend 
Show Takeoff 

 Show Measurements 

Job data displayed at the 
bottom of the print out is 
customizable in the BidScreen 
XL | Setup under the Reports 
tab. 

 

Print to PDF format 

The available print commands 
are found at the top of the Print 
Preview window. 

Print Scale 

http://www.vertigraph.com/


 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Leave as current user, if your login provides 

the privilege to install, and uncheck the box 

next to "Protect my computer..." 

“An access denied” error will occur if left 

checked.  Click ok to continue. 

Click “Yes” to begin installing the 
update. 

 

 

 

Updates are sent periodically to fix bugs and to update and upgrade software products.  These updates are done 
electronically via the web and notifications are prompted weekly when available for each product. When in doubt, you 
can also manually check for updates thru the programs menu option in MS Excel by clicking on the Check 
Updates option. To ensure the latest version is installed and your software continues proper operation, it is imperative 
that updates are performed.  The following will illustrate how to update the Excel Add-in Programs, BidPoint XL and 
BidScreen XL.  Your company's full serve must be up to date in order to receive updates and upgrades. 

If the Current User does not have 
the proper privileges to install, 
select "The following user" and 
type the proper administrator 

login.  Click ok. 

The Update Setup Wizard will begin. 

Click OK 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

  

 

 

You are prompted twice to Save Your 
Work and Close Excel.  

An error message will appear if 
the program is not closed.  Save 

your work, Close the program 
as usual and Click next. 

All updates are placed in this 
folder under the path file name. 
Click Next. 

 

Click Install. 



 

 

 

Your BidPoint XL and/or BidScreen XL software is now up to date. If you have 
any questions or need assistance please email support@vertigraph.com and 

include your Name, Company and Product Serial # located as follows: 

 

Click the Finish button to 
Complete the Update Wizard 

mailto:support@vertigraph.com�


For further information, contact: 
Ms. Kim Border 
Vertigraph, Inc. 
214-340-9436 
kborder@vertigraph.com 

 
 

Vertigraph, Inc. to bundle its quantity takeoff software with Adobe Acrobat 9 
 
 
Dallas, TX (March 31, 2009) Vertigraph, Inc. has entered into a Value Added Bundle Agreement with Adobe 
System Incorporated and Adobe Systems Software Ireland Limited whereby Vertigraph, Inc. will bundle its 
BidScreen XL and SiteWorx/OS software with Adobe Acrobat 9 Standard.   
 
Vertigraph, Inc., incorporated in 1991 and a worldwide leader in the development of takeoff and estimating software 
for the construction industry, appears to be the first and only takeoff and estimating software entity to join Adobe in 
revolutionizing how the world engages with ideas and information by offering a bundle of its innovative on-screen 
digitizing solutions with Adobe Acrobat. Adobe Acrobat 9 Standard now ships with BidScreen XL and/or 
SiteWorx/OS and will be made available for those Vertigraph customers not currently using Adobe Acrobat Version 
7 or later.  
 
Kim Border of Vertigraph states “Bundling Vertigraph’s latest BidScreen XL and SiteWorx/OS on-screen digitizing 
software with Adobe Acrobat Version 9 provides the construction professional with the complete solution.  
Estimators and Quantity Surveyors can conveniently work with the native electronic file without the need of time 
consuming file conversions.  BidScreen XL and SiteWorx/OS bundled with Adobe Acrobat will now access all 
versions of PDF files with clarity and without regard to their origination.”  
 
Most competing electronic takeoff software applications either automatically force a conversion of the native file 
into their propriety format, thus making the original file useless in any other imaging software accept theirs; or have 
limited functionality with certain PDF files and/or display pdf images that are distorted and grainy, both requiring 
time consuming file conversion processes that are subject to error and problems. Vertigraph has recognized and 
addressed these issues. Now you’ll no longer need to contact the author of the file to request them to re-save the 
PDF files in an alternate format which has long been, and still remains, a standard fix when dealing with PDF files.  
 
Corina Harrison of Vertigraph states, “Vertigraph appears to be the first and only takeoff and estimating software 
entity to recognize the wide use and distribution of PDF files in the construction industry and compatibility issues 
that exist when using any on-screen digitizing software. By bundling Acrobat Standard with our BidScreen XL on-
screen digitizing software for MS Excel, the construction professional now has the ability to record measurements 
and digitized drawing information from an expanded variety of native file formats, documenting their quantity 
takeoff into any MS Excel workbook with the added document management capabilities of the popular, industry 
leading, Adobe Acrobat software.  Construction professionals can now manage their electronic files and quantity 
takeoffs with two of the most popular and widely utilized software applications - Microsoft Excel and Adobe 
Acrobat.”  
 
Vertigraph’s SiteWorx/OS application also uses Adobe Acrobat to work with the native PDF files and provides cut 
and fill calculations from virtually any file format. Three dimensional graphics are automatically generated with 
SiteWorx/OS. 
 
Erich Schoenkopf of Vertigraph adds “Digitizing measurements on-screen offers many benefits in comparison to 
quantity takeoff from paper blueprints.  By digitizing on-screen, the volume of paper is significantly reduced 
resulting in a greener environment.  By reducing the volume of paper, you’ll reduce your paper costs resulting in a 
superior return on investment.  Other benefits of on-screen digitizing include increased speed, improved accuracy 
with a clear, concise audit trail and the ability to work anywhere.  You’re no longer tied down to blueprints and a 
digitizer tablet for quantity takeoff with Vertigraph’s BidScreen XL and SiteWorx/OS software.” 
 
Vertigraph mission is to exceed your expectations and provide you with the software solutions that quickly add 
value to your business.   
  



Vertigraph Excel Tips & Tricks 

For BidPoint XL & BidScreen XL Software 
 

Excel 2007 Hotkeys/Keyboard Command Shortcuts Gone? 
 

To view your Hotkey/Keyboard Commands open MS Excel 2007 simply depress your “Alt” key on your 

keyboard. This will display the new keyboard commands.  

BidPoint XL users: 

New Hotkey/Keyboard Command setup from your digitizer Tabletworks Control Panel: 

 

 Scale (or Change Drawing) = Alt + X, C, 1 

 Count = Alt + X, C, 2 

 Section Length = Alt + X, C, 3 

 Continuous Length = Alt + X, C, 4 

 Area = Alt + X, C, 5 

 Section Length = Alt + X, C, 3 

 
 

 

 

 



Customize your Quick Access Toolbar with your favorite functions and go straight to what your looking 

for! 

 

 
 

 

From your Office Button   in MS Excel select “Excel Options”. 

This will prompt you to the Excel Options window where you should select the Customize menu on the 

left hand side. 

 

From the All Commands List select “Add-Ins” and then the Add button in the center of the page and 

select  “Customize Quick Access Toolbar” and then the Add button. This will add shortcut buttons to 

your Add-In list and your Excel Options right on your Quick Access Toolbar. 

 

 

 
 

Now add your Vertigraph software Menu and Toolbars right to your Quick Access Toolbar so they are 

always quickly accessible: 

 



From the Customize menu on the left hand side of the Excel Options select the Add-Ins Tab. Click on 

Custom Toolbars and click the Add button in the center of the page and then select Menu Commands 

and click the Add button in the center of the page and then click OK. 

 

 
 

 

 

For Excel 1997 – 2003 users: 
 

Please note this does not apply to Excel 2007.  To increase the size of your Toolbar buttons and/or 

change the width of a drop-down list box on a toolbar please perform the following: 

  

1. On the Tools menu in MS Excel, click Customize 

2. Make sure the toolbar you want o change is visible. 

3. With the Customize dialog box open, click the list box you want to change….. for example 

 

 on the Formatting toolbar. 

4. Point to the left or right edge of the box. When the pointer changes to a double-headed arrow, 

drag the edge of the box to change its width. 

 

 


